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Overview
This guide provides information for installing the HP Helion Codar application. Successful
implementation of the application requires knowledge of the integrated products, as well as the
HP Helion Codar solution. Information in this guide augments information provided in the integrated
products documentation but is not intended to replace that documentation. Primary product
documentation contains themost up-to-date information. Cross-references are provided to those
documents where appropriate.

System requirements
You should review theHP Helion Codar System and Software Support Matrix for version requirements.

You can get this document from the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.
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Oracle Database
Youmust complete the following installation and configuration steps if you wish to useOracle
Database with HP Helion Codar.

Install Oracle Database
For a list of supported database versions, refer to theHP Helion Codar System and Software Support
Matrix, which is available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Install the database according to themanufacturer’s documentation. Database installation is typically
done in partnership with a database administrator.

Download Oracle JDBC drivers
For a list of supported JDBC driver versions, refer to theHP Helion Codar System and Software
Support Matrix, which is available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Download a supported version of the JDBC .jar file(s) and save them on the system onwhich
HP Helion Codar will be installed. Record the location where you save the files, because this
informationmust be provided when you install HP Helion Codar.

Configure Oracle
These tasks must be completed before HP Helion Codar is installed.

Create a database instance for embedded HP Operations
Orchestration
Work with the database administrator to create a database that is used by the embedded HP
Operations Orchestration.
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Configure user and schema for embedded HP Operations
Orchestration
A database user for embedded HP Operations Orchestration is required. Work with the database
administrator to do the following (or refer to themanufacturer’s documentation for more information):

Caution: The database name and user name cannot contain more than one dollar sign symbol ($).

1. Create a schema for the embedded HP Operations Orchestration by creating a database user.

2. Grant the following privileges to the user:
n CONNECT

n CREATE VIEW

n CREATE SEQUENCE

n CREATE TABLE

n CREATE PROCEDURE

For example, run the following commands to create the codaroodbuser user:

Create user codaroodbuser identified by codaroodbuser default tablespace system
temporary tablespace temp quota unlimited on system account unlock;
Grant CONNECT to codaroodbuser;
Grant CREATE VIEW, CREATE SEQUENCE, CREATE TABLE, CREATE PROCEDURE to
codaroodbuser;
Commit;

Create a database instance for HP Helion Codar
If the database instance used by HP Helion Codar has not already been created, work with the
database administrator to create this database.

Configure role and user for HP Helion Codar
A database user is needed when installing HP Helion Codar. Work with the database administrator to
do the following (or refer to themanufacturer’s documentation for more information):

Caution: The database name and username cannot contain more than one dollar sign symbol ($).

1. Create a schema for HP Helion Codar by creating a database user (for example, codardbuser).

2. Create a role for this HP Helion Codar database user (for example, codardbrole) and grant the
following privileges to the role:

Installation and Configuration Guide
Oracle Database
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n CREATE SESSION

n CREATE TABLE

n CREATE VIEW

n CREATE SEQUENCE

n CREATE ANY SYNONYM

3. Grant the role to the HP Helion Codar database user.

4. Alter the HP Helion Codar database user by setting this role as the user's default role.

For example, run the following commands to create codardbrole and codardbuser:

Create user codardbuser identified by codardbuser;
Create role codardbrole;
Grant CREATE SESSION, CREATE TABLE, CREATE VIEW, CREATE SEQUENCE, CREATE ANY
SYNONYM to codardbuser;
Grant codardbrole to codardbuser;
Alter user codardbuser default role codardbrole;

Youmust provide this user name and password when prompted for the HP Helion Codar database user
during installation.

If you configure this user, youmust provide this user name and password when prompted for the Helion
Codar reporting database user during the installation of HP Helion Codar.

Configure Oracle for localization
If you need to support localization, the Oracle database instancemust support UTF-8 character
encoding andmulti-byte characters. Work with the database administrator to set the following
parameters to the specified values (or refer to themanufacturer’s documentation for more information):

l NLS_CHARACTERSET = AL32UTF8

l NLS_LENGTH_SEMANTICS = CHAR

Create a tablespace for HP Helion Codar (Recommended)
For performance reasons, HP recommends that you create a new tablespace which stores LOBs for
the CSA_DOCUMENT table. Work with the database administrator to create a tablespace to be used
by HP Helion Codar (or refer to themanufacturer’s documentation for more information). HP
recommends that the initial tablespace size should be at least 3 GB.

The tablespacemust be created before installing HP Helion Codar and thenmust be configured
immediately after HP Helion Codar is installed.
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Microsoft SQL Server
Youmust complete the following installation and configuration steps if you wish to useMS-SQLwith
HP Helion Codar.

Install Microsoft SQL Server
Refer toHP Helion Codar System and Software Support Matrix for a list of supported database
versions, available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Database installation is typically done in partnership with a database administrator. Microsoft SQL
Server must be installed with mixedmode authentication. During the installation of Microsoft SQL
Server, from the Database Engine Configuration dialog, for the authenticationmode, selectMixed
Mode (SQL Server authentication and Windows authentication).

Configure Microsoft SQL Server
These tasks must be completed before hp Helion Codar is installed. Work with the database
administrator to complete the following tasks, or refer to themanufacturer’s documentation for more
information.

Enable TCP/IP
TCP/IP must be enabled on theMicrosoft SQL Server in order for HP Helion Codar to access the
database. By default, TCP/IP may be disabled on theMicrosoft SQL Server. Verify the TCP/IP
configuration.

From the SQL Server ConfigurationManager:

1. Select SQL Server Network Configuration > Protocols for <instance_name>.

2. Double-Click TCP/IP to open the TCP/IP Properties dialog.

3. From the TCP/IP Properties dialog, select the IP Addresses tab.

4. Verify that TCP/IP is active and enabled, and verify that the TCP port is set to 1433. Update any
properties that are not set correctly.

Configure a user for HP Helion Codar
AnHP Helion Codar database user is needed when installing HP Helion Codar.

Caution: The database name and user name cannot contain more than one dollar sign symbol ($).
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To create a database user for HP Helion Codar, do the following:

1. Create a new database for HP Helion Codar.

Caution: Use the default database option collation value of SQL_Latin1_General_CP1_CI_
AS.

Do NOT use the collation value SQL_Latin1_General_CP1_CS_AS. HP Helion Codar does
not work with a database that is configured with this collation value.

2. Add a database user with the following roles:
n db_datareader

n db_datawriter

n db_owner

Youmust provide this user name and password when prompted for the HP Helion Codar database user
during installation.

Configure a user for HP Operations Orchestration
AnHP Operations Orchestration database user, used by the embedded HP Operations Orchestration,
is needed when installing HP Helion Codar.

Caution: The database name and user name cannot contain more than one dollar sign symbol ($).

To create an HP Operations Orchestration database user for HP Helion Codar, do the following:

1. Create a new database for HP Operations Orchestration.

As of the release date of the HP Helion Codar software (found at the beginning of this guide), the
mandatory database options for theMicrosoft SQL Server for HP Operations Orchestration are:

n Allow Snapshot Isolation: True

n Is Read Committed Snapshot On: True

n Auto Shrink: False

n Auto Create Statistics: True

Caution: You should verify the latest mandatory options and follow the instructions in theHP
Operations Orchestration DatabaseGuide.

Installation and Configuration Guide
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Note: HP Operations Orchestration recommends using the database option collation value of
SQL_Latin1_General_CP1_CS_AS. When creating the database used by HP Operations
Orchestration, this collation value is valid.

2. Add an HP Operations Orchestration database user with the following roles:
n db_datareader

n db_datawriter

n db_owner

Youmust provide this user name and password when prompted for the HP Operations Orchestration
database user during the installation of HP Helion Codar.

Create a filegroup
For performance reasons, HP recommends that you associate a new filegroup with the CSA_
DOCUMENT table. Work with the database administrator to configure a filegroup to be used by
HP Helion Codar (or refer to themanufacturer’s documentation for more information). HP recommends
that the initial filegroup size should be at least 3 GB.

The filegroup is configured after HP Helion Codar is installed.

Installation and Configuration Guide
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PostgreSQL
Youmust complete the following installation and configuration steps if you wish to use PostgreSQL
with HP Helion Codar.

Install PostgreSQL
Refer toHP Helion Codar System and Software Support Matrix for a list of supported database
versions, available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Install the database according to themanufacturer’s documentation. Database installation is typically
done in partnership with a database administrator.

Configure PostgreSQL
These tasks must be completed before HP Helion Codar is installed. Work with the database
administrator to complete the following tasks (or refer to themanufacturer’s documentation for more
information).

Configure users and database
At least two database users are needed when installing HP Helion Codar. Do the following:

1. On the system hosting the database, install postgresql-clientpostgres-client.rpm if it is not
already installed. As the root user, enter the following:

apt-get install postgresql-clientrpm -ivh postgres-client.rpm

2. Set the shared library path to include the PostgreSQL libraries (<postgresql_
installation>/lib). For example, if you installed PostgreSQL in /opt/PostgreSQL/9.2/, run
the following command:

export LD_LIBRARY_PATH=/opt/PostgreSQL/9.2/lib:$LD_LIBRARY_PATH

3. Log in to psql as the postgres user. Enter the following:

psql -h localhost -U postgres -d template1

When prompted, enter the password for the postgres user.

4. Create an HP Helion Codar database user (for example, csadbuser). The HP Helion Codar
database user is required. This user should inherit rights from parent roles and be a superuser.
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Caution: The user name cannot contain more than one dollar sign symbol ($).

From the psql prompt, enter the following:

create role codardbuser login password '<codardbuser_password>' superuser
inherit;

Youmust provide this user name and password when prompted for the HP Helion Codar database
user during installation.

Installation and Configuration Guide
PostgreSQL

HP Helion Codar (1.00) Page 16 of 72



Install HP Operations Orchestration
Install HP Operations Orchestration to the correct version and patch level. SeeHP Helion Codar
System and Software Support Matrix for version requirements, available on the HP Software Support
web site at http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with
HP Passport.

If you are using an existing installation of HP Operations Orchestration, you should verify that the
correct versions of patches and updates have been applied.

Configure an internal user
This internal user is used to configure HP Operations Orchestration for HP Helion Codar. This step is
required if you are going to integrate HP Operations Orchestration with HP Helion Codar using the
installer.

1. Log in to HP Operations Orchestration Central.

2. Click theSystem Configuration button.

3. Select Security > Internal Users.

4. Enter the following information:

Field Recommended value

User Name admin

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

5. Click Save.

6. Enable authentication by selectingEnable Authentication.

7. Click OK in the confirmation dialog.

Export the HP Operations Orchestration root
certificate
Export the HP Operations Orchestration certificate from the HP Operations Orchestration truststore
and, if HP Operations Orchestration and HP Helion Codar are not installed on the same system, copy
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the certificate to the HP Helion Codar system. This certificate will be imported into the HP Helion
Codar truststore by the HP Helion Codar installer. SSLmust be configured between HP Helion Codar
and HP Operations Orchestration.

For example, do the following:

1. On the system running HP Operations Orchestration, open a command prompt and change to the
directory where HP Operations Orchestration is installed.

2. Run the following command:

For HP Operations Orchestration 10.20 on Windows:
.\java\bin\keytool -export -alias tomcat -file C:\oo.crt -
keystore .\Central\var\security\key.store -storepass changeit

For HP Operations Orchestration 9.07 on Windows:
.\jre1.6\bin\keytool -exportcert -alias pas -file C:\oo.crt -
keystore .\Central\conf\rc_keystore -storepass bran507025

For HP Operations Orchestration 10.20 on Linux:
./java/bin/keytool -export -alias tomcat -file /tmp/oo.crt -
keystore ./Central/var/security/key.store -storepass changeit

For HP Operations Orchestration 9.07 on Linux:
./jre1.6/bin/keytool -exportcert -alias pas -file /tmp/oo.crt -
keystore ./Central/conf/rc_keystore -storepass bran507025

where C:\oo.crt and /tmp/oo.crt are examples of filenames and locations used to store the
exported root certificate (you can choose a different filename and location).

3. If HP Operations Orchestration is not running on the same system as HP Helion Codar, copy
oo.crt from the HP Operations Orchestration system to the system running HP Helion Codar.

Installation and Configuration Guide
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Install HP Helion Codar on Windows

Note: Installation log files are written to the %CODAR_HOME%\_HELION_Codar_1_00_0_
installation\Logs\ folder.

To install HP Helion Codar, complete the following steps.

1. Close all instances of Windows Explorer and command prompts and exit all programs that are
running on the system.

2. Run the setup.exe installation file.

3. On the Introduction screen, read the information and click Next.

4. Read the license agreement and select I accept the terms of the License Agreement. Click
Next to continue with the installation.

If the following error message is displayed:

Another version of HP Helion Codar is configured in the registry. However,
HP Helion Codar has been uninstalled (the HP Helion Codar installation folder
%CODAR_HOME% does not exist). You must exit the installer and delete the entry
in the registry before installing HP Helion Codar. Refer to the HP Helion Codar
Installation Guide for more information about deleting the registry entry.

exit the installer. Locate the C:\Program Files\Zero G Registry\.com.zerog.registry.xml
file (youmay need to show hidden files), make a backup copy, delete all HP Helion Codar entries
from the .com.zerog.registry.xml file, and restart the installer.

5. Select HP Helion Codar and click Next.

6. Choose a location in which to install HP Helion Codar and click Next (%CODAR_HOME% is set to this
location).

The default location is C:\Program Files\Hewlett-Packard\Codar.

Note: If the folder in which you choose to install HP Helion Codar is not empty, existing
content in the folder may be overwritten or deleted when HP Helion Codar is installed,
upgraded, or uninstalled.

Caution: The entire folder path cannot contain more than one dollar sign symbol ($).

7. Choose the JRE that will be used by HP Helion Codar.
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In this documentation, the folder in which the JRE is installed will be referred to as <codar_jre>.

For a list of supported JREs, refer to theHP Helion Codar System and Software Support Matrix,
available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP
Passport.

OpenJDK JRE

TheOpenJDK JRE is bundled with HP Helion Codar. If you want to use the OpenJDK JRE, click
Open JRE and click Next.

The default location in which the OpenJDK JRE is installed is C:\Program Files\Hewlett-
Packard\Codar\openjre.

Oracle JRE

If you have installed a supported version of Oracle JRE to be used by HP Helion Codar, click
Oracle JRE, select the location in which you installed this JRE, and click Next.

The default location displayed for the Oracle JRE Home is either a supported JRE that is
configured in the system registry or a supported JRE in a path that is defined in the system path
variable. If this is not the JRE that should be used by HP Helion Codar, click Choose and select
the location in which you installed the JRE that will be used by HP Helion Codar.

8. Select the type of database installed and click Next.

For anOracle database, youmust also enter the JDBC Driver Directory. This is the absolute
folder path to the location of the JDBC drivers (these are the JDBC drivers you downloaded onto
the HP Helion Codar system). For a list of supported JDBC driver versions, refer to theHP Helion
Codar System and Software Support Matrix, available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP
Passport.

9. Define the database instance on which the HP Helion Codar database components should be
installed or where the HP Helion Codar database schema already exists. Enter the following
database information and click Next.

Field Description

Database
Host

The host name or IP address of the server where the database is located. When
specifying an IPv6 address, it must be enclosed in square brackets. For example,
[f000:253c::9c10:b4b4] or [::1].

Database
Port

The database port number, such as 1433 (Microsoft SQL Server),1521 (Oracle), or
5432 (PostgreSQL).

Installation and Configuration Guide
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Field Description

Database
Name
Oracle
SID

The name of the database instance on which the HP Helion Codar database
schemawill be installed. If you are creating a new HP Helion Codar database
schema, this is the name of the database instance on which the HP Helion Codar
database components will be installed. If you are using an existing HP Helion
Codar database schema that was created as part of a prior successful installation
of HP Helion Codar version HP 1.00, this is the name of the database instance on
which the HP Helion Codar database schema exists. For anOracle database, this
is the System ID (SID).

Database
Username

The user name of the database user you configured for HP Helion Codar in the
database (for example, codardbuser).

Database
Password

The password for the database user.

10. Install HP Helion Codar database components onto the database instance to create the database
schema, if it does not exist.

Click Yes to install HP Helion Codar database components and create the database schema.
When you select this option, the HP Helion Codar service automatically starts when you exit the
installer.

Click No if you are using an existing HP Helion Codar database schema that was created as part
of a prior successful installation of HP Helion Codar version 1.00. When you select this option, the
HP Helion Codar service does not start when you exit the installer. Refer to the end of this section
for information on how to start and stop the service.

11. From the Enter host name screen, enter the fully-qualified domain name of the system on
which you are installing HP Helion Codar. The fully-qualified domain name is used to generate
the self-signed SSL certificate which is used when https browser requests are issued for HP
Helion Codar. This self-signed certificate expires 120 days after HP Helion Codar is installed.

12. By default, HP Single Sign-On (HP SSO) is included with HP Helion Codar and is enabled. The
HP SSO that is included can only be used when launching an application, such as HP Operations
Orchestration, from theManagement Console. Refer to theHP Cloud Service Automation
Configuration Guide the HP SSO documentation for more information on integrating HP SSOwith
an application.

If you do not want to use HP SSO, you can disable it.

YouMUST disable HP Single Sign-On if you are installing HP Helion Codar in a FIPS 140-2
compliant environment.

If enabled, enter the domain name of the network to which the server on which you are installing
HP Helion Codar belongs and click Next.

Installation and Configuration Guide
Install HP Helion Codar onWindows

HP Helion Codar (1.00) Page 21 of 72



Note: Youmust enter the full domain name of the server. For example, if you are installing HP
Helion Codar on a system whose fully-qualified domain name is
machine1.development.xyz.com, youmust enter development.xyz.com. If you enter only
xyz.com, you will not be able to log in to theManagement Console.

Applications launched from theManagement Console with which you want to use HP SSOmust
be installed on systems that belong to this domain.

13. Specify if you want to install the embedded (new) HP Operations Orchestration instance with
HP Helion Codar or if you are integrating with an external (existing) instance of HP Operations
Orchestration.

Select Use external OO and click Next and select Enter to integrate with an external (existing)
instance of HP Operations Orchestration.

Select Install embedded OO and click Next and select Enter to install the embedded HP
Operations Orchestration.

14. Define the HP Operations Orchestration instance with which HP Helion Codar is to be integrated.
Enter the following information and click Next.

Field Description

HP OO
Hostname

The fully-qualified domain name or IP address of the server where HP Operations
Orchestration is located. Specify the hostname that was used to generate HP
Operations Orchestration's certificate. The hostname is used for SSL validation
and to build the URL that theManagement Console uses to interact with HP
Operations Orchestration (for example, in the subscription event overview section
of theOperations area in HP Helion Codar, selecting the Process ID opens HP
Operations Orchestration to the detailed page of the selected process when these
properties are configured).

When specifying an IPv6 address, it must be enclosed in square brackets. For
example, [f000:253c::9c10:b4b4] or [::1].

HP OO
Port

The
port number used to communicate with HP Operations Orchestration, such as
8443. By default, HP Operations Orchestration uses this port and port 8080.

Caution: You should ensure that port 8080 is not being used on the system
where you install HP Helion Codar and the embedded HP Operations
Orchestration. If this port is used, then HP Operations Orchestration flows will
not work properly.
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Field Description

HP OO
User

The name of the user who logs in to HP Operations Orchestration Central. HP
recommends that you use the admin user. If you followed all the steps documented
in the Install HP Operations Orchestration section of this guide, this is the admin
user.

HP OO
Password

The password used to log in to HP Operations Orchestration Central.

HP OO
Certificate
File

The file name and location of HP Operations Orchestration's certificate from HP
Operations Orchestration's truststore on the HP Helion Codar system. If you have
not already done so, export HP Operations Orchestration's certificate and copy it
to the HP Helion Codar system.

Note: This information is used to set the HP Operations Orchestration properties in the
codar.properties file and import HP Operations Orchestration's certificate into HP Helion
Codar's truststore.

15. If you are installing embedded HP Operations Orchestration, choose a location and click Next.

16. Configure an internal HP Operations Orchestration user and click Next. This user is used for
provisioning topology designs.

Field name Description

HP OOUser
Name

The name of the user for provisioning topology designs. This user is given the
ADMINISTRATOR and SYSTEM_ADMIN roles.

HP OOUser
Password

The password used by HP Operations Orchestration for the user who
provisions topology designs.

17. Enter the database information for the database used by the embedded HP Operations
Orchestration and click Next. The database used by the embedded HP Operations Orchestration
must be the same type of database used by HP Helion Codar.

Field name Description

MSSQL, Oracle, or
PostgreSQLDatabase
Host

The hostname or IP address of the server where the embedded
HP Operations Orchestration database is located.

MSSQL, Oracle, or
PostgreSQL Database
Port

The embedded HP Operations Orchestration database port
number, such as 1433 (Microsoft SQL Server),1521 (Oracle), or
5432 (PostgreSQL).
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Field name Description

HP OODatabase Name or
Oracle HP Operations
Orchestration SID

The name of the database instance used by the embedded HP
Operations Orchestration. For anOracle database, this is the
System ID (SID).

HP OODatabase
Username

The user name of the database user you configured for the HP
Operations Orchestration database in appropriate database
configuration section of this guide.

HP OODatabase
Password

The password for the HP Operations Orchestration database
user.

18. Review your selections and click Install to complete the installation.

19. Youmay be asked to restart your system.

Click Yes, restart my system to restart your system when you exit the installer.

Click No, I will restart my system myself to restart your system at amore convenient time.

20. Click Done to exit the installer.

21. Verify that the HP Helion Codar services have started by navigating toControl Panel >
Administrative Tools > Services. The servicemay take up to fiveminutes to start. If the service
has not started, right-click on the service and select Start.

The installer creates the HP Helion Codar services. If you opted to install the HP Helion Codar
database components, the installer also starts these services. The HP Helion Codar servicemust
be running before you can access theManagement Console.
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Install HP Helion Codar on Linux

Configure a group and user
Configure a group and user for HP Helion Codar:

1. Log in to the system as the root user.

2. Create a group called codargrp. Enter the following:

addgroup codargrp (Ubuntu)
groupadd codargrp (Red Hat Enterprise Linux)

3. Create a user called codaruser and assign this user to the codargrp. Enter the following:

adduser -g codargrp-m codaruser (Ubuntu)
useradd -g codargrp-m codaruser -s /bin/bash (Red Hat Enterprise Linux)

4. Assign a password to the codaruser. Enter the following:

passwd codaruser

When prompted, enter the password.

Install HP Helion Codar

Note: Installation log files are written to the $CODAR_HOME/_HELION_Codar_1_00_0_
installation/Logs/ directory and are named codar_*.txt.

To install HP Helion Codar, complete the following steps.

1. Log in to the system as the root user.

2. Install the unzip utility if it is not already installed. Enter the following:

apt-get install unzip

3. Create an installation directory for HP Helion Codar (this document assumes that you will install
the product in /usr/local/hp/codar and all examples used in this document are based on this
assumption). Enter the following:

mkdir -p /usr/local/hp/codar
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4. For the installation directory, set the owner to codaruser and the group to codargrp. Enter the
following:

chown -R codaruser:codargrp /usr/local/hp/codar

5. Log out as the root user and log in as codaruser.

6. Copy the HP Helion Codar installation file (setup.bin) to the system and go to the directory in
which it has been copied.

7. Verify that setup.bin is owned by codaruser and that this user has full permissions for the file. If
necessary, do the following:

a. Log in as the root user

b. Enter one or both of the following commands:

chown codaruser setup.bin
chmod u+rwx setup.bin

c. Log out as the root user and log in as codaruser.

d. Check the values of the CODAR_HOME, PS1, and TITLEBAR environment variables. If they
are set, verify that they do not contain any escape sequences. If any of these variables
contain an escape sequence, the variable will cause the installer to fail. The variable must
either be reset to a value that does not contain an escape sequence or must be unset.

8. Run the setup.bin installation file.

Note: Youmust run setup.bin as the codaruser. If you install as another user, youmay not
be able to run HP Helion Codar.

As the codaruser, enter the following:

./setup.bin

9. Read the Introduction and press Enter to continue with the installation.

10. Read the license agreement. Press Enter to scroll through the entire agreement.

11. Select Y andEnter to accept the license agreement and continue with the installation. Select N
press Enter to exit the installation.

If the following error message displays:

Another version of HP Helion Codar is configured in the registry. However,
HP Helion Codar has been uninstalled (the HP Helion Codar installation
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directory $CODAR_HOME does not exist). You must exit the installer and delete
the entry in the registry before installing HP Helion Codar. Refer to the HP
Helion Codar Installation Guide for more information about deleting the
registry entry.

exit the installer. Locate the $HOME/.com.zerog.registry.xml file (for example,
/home/codaruser/.com.zerog.registry.xml), make a backup copy, delete all HP Helion
Codar entries from the .com.zerog.registry.xml file, and restart the installer.

12. Select HP Helion Codar and press Enter.

13. Enter a location in which to install HP Helion Codar (enter the absolute path to the location) and
press Enter. Or, press Enter to accept the default location.

The default location is /usr/local/hp/codar.

Note: If the directory in which you choose to install HP Helion Codar is not empty, existing
content in the directory may be overwritten or deleted when HP Helion Codar is installed,
upgraded, or uninstalled.

If prompted, verify the installation folder. If the folder is correct, select Y andEnter to continue
with the installation. If the folder is not correct, select N andEnter to re-enter the installation
folder.

14. Choose the JRE that will be used by HP Helion Codar.

In this documentation, the directory in which the JRE is installed will be referred to as $CODAR_
JRE_HOME.

For a list of supported JREs, refer to theHP Helion Codar System and Software Support Matrix,
available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP
Passport.

OpenJDK JRE

TheOpenJDK JRE is bundled with HP Helion Codar. If you want to use the OpenJDK JRE, type
1 and press Enter.

The default location in which the OpenJDK JRE is installed is /usr/local/hp/codar/openjre.

Oracle JRE

If you have installed a supported version of Oracle JRE to be used by HP Helion Codar, type 2 and
press Enter. Type the location in which you installed this JRE and press Enter.

The default location displayed for the Oracle JRE Home is either a supported JRE that is
configured in the system registry or a supported JRE in a path that is defined in the system path
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variable. If this is not the JRE that should be used by HP Helion Codar, type in the location in
which you installed the JRE that will be used by HP Helion Codar and press Enter.

15. Define the database instance on which the HP Helion Codar database components should be
installed. Enter the following database information (press Enter after each entry).

a. Enter the type of database you have installed: MSSql (Microsoft SQL Server), Oracle, or
Postgres (PostgreSQL).

For anOracle database, youmust also enter the JDBC Driver Directory. This is the absolute
directory path to the location of the JDBC drivers (these are the JDBC drivers you
downloaded onto the HP Helion Codar system). For a list of supported JDBC driver versions,
refer to theHP Helion Codar System and Software Support Matrix, available on the HP
Software Support web site at http://h20230.www2.hp.com/selfsolve/manuals/. This site
requires that you register with HP Passport.

b. Enter the database hostname. This is the hostname or IP address of the server where the
database is located. When specifying an IPv6 address, it must be enclosed in square
brackets. For example, [f000:253c::9c10:b4b4] or [::1]. The default value is the IP
address of the localhost (127.0.0.1).

c. Enter the database port. This is the database port number, such as 1433 (Microsoft SQL
Server), 1521 (Oracle), or 5432 (PostgreSQL).

d. Enter the database name. This is the name of the database instance on which the HP Helion
Codar database schemawill be installed. If you are creating a new HP Helion Codar database
schema, this is the name of the database instance on which the HP Helion Codar database
components will be installed. If you are using an existing HP Helion Codar database schema
that was created as part of a prior successful installation of HP Helion Codar version HP 1.00,
this is the name of the database instance on which the HP Helion Codar database schema
already exists.

If you followed the examples in this document, enter codardb.

e. Enter the Helion Codar database user name. This is the user name of the database user you
configured for HP Helion Codar in the appropriate database configuration section of this guide.

If you followed the examples in this document, enter codardbuser.

f. Enter the Helion Codar database password. This is the password for the Helion Codar
database user.

16. Install HP Helion Codar database components onto the database instance to create the HP Helion
Codar database schema, if it does not already exist.

Type yes to install HP Helion Codar database components and create the HP Helion Codar
database schema. When you select this option, the HP Helion Codar process automatically starts
when you exit the installer.
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Type no if you are using an existing HP Helion Codar database schema that was created as part
of a prior successful installation of HP Helion Codar version 1.00. When you select this option, the
HP Helion Codar process does not start when you exit the installer. Refer to the end of this
section for information on how to start and stop the HP Helion Codar service.

17. Enter the HP Helion Codar server host name. This is the fully-qualified domain name of the
system on which you are installing HP Helion Codar. The fully-qualified domain name is
used to generate the self-signed SSL certificate which is used when https browser requests are
issued for HP Helion Codar. This self-signed certificate expires 120 days after HP Helion Codar is
installed.

Caution: If you enter an IP address, after installation completes, youmust manually generate
a self-signed certificate using the fully-qualified domain name of the system onwhich you
installed HP Helion Codar andmanually reconfigure HP Helion Codar to use this certificate.

18. By default, HP Single Sign-On (HP SSO) is included with HP CSA and is enabled. The HP SSO
that is included with HP CSA can only be used when launching an application, such as HP
Operations Orchestration or HP IT Executive Scorecard, from the Cloud ServiceManagement
Console. Refer to the HP Cloud Service Automation Configuration Guide and HP SSO
documentation for more information on integrating HP SSOwith an application.

If you do not want to use HP SSO, you can disable it. Type 2 and select Enter.

To enable HP SSO, type 1 and select Enter. Enter the Domain name of the network to which the
server belongs (the server on which you are installing HP CSA) and select Enter.

Note: Youmust enter the full domain name of the server. For example, if you are installing HP
CSA on a system whose fully-qualified domain name is machine1.marketing.xyz.com, you
must enter marketing.xyz.com. If you enter only xyz.com, you will not be able to log in to the
Cloud ServiceManagement Console.

Applications launched from the Cloud ServiceManagement Console with which you want to use
HP SSOmust be installed on systems that belong to this domain.

19. Specify if you want to install the embedded (new) HP Operations Orchestration instance with
HP Helion Codar or if you are integrating with an external (existing) instance of HP Operations
Orchestration.

Select 1 andEnter to integrate with an external (existing) instance of HP Operations
Orchestration.Select 2 andEnter to install the embedded HP Operations Orchestration.

20. Define the HP Operations Orchestration instance with which HP Helion Codar is to be integrated.
Enter the following information (press Enter after each entry).
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a. Enter the HP OO host name. This is the fully-qualified domain name or IP address of the
server where HP Operations Orchestration is located. Specify the hostname that was used to
generate the HP Operations Orchestration certificate. The hostname is used for SSL
validation and to build the URL that theManagement Console uses to interact with HP
Operations Orchestration (for example, in the subscription event overview section of the
Operations area in HP Helion Codar, selecting the Process ID opens HP Operations
Orchestration to the detailed page of the selected process when these properties are
configured).

When specifying an IPv6 address, it must be enclosed in square brackets. For example,
[f000:253c::9c10:b4b4] or [::1].

b. Enter the HP Operations Orchestration port. This is the
port number used to communicate with HP Operations Orchestration, such as 8443. By
default, HP Operations Orchestration uses this port and port 8080.

Caution: You should ensure that port 8080 is not being used on the system where you
install HP Helion Codar and the embedded HP Operations Orchestration. If this port is
used, then HP Operations Orchestration flows will not work properly.

c. Enter the HP Operations Orchestration user name. This is the name of the user who logs in to
HP Operations Orchestration Central. HP recommends that you use the admin user. If you
followed all the steps documented in the Install HP Operations Orchestration section of this
guide, this is the admin user.

d. Enter the HP Operations Orchestration password. This is the password used to log in to HP
Operations Orchestration Central.

e. Re-enter the HP Operations Orchestration password.

f. Enter the HP Operations Orchestration certificate file. This is the file name and location of HP
Operations Orchestration's certificate from HP Operations Orchestration's truststore on the
HP Helion Codar system. If you have not already done so, export the HP Operations
Orchestration certificate and copy it to the HP Helion Codar system (see the Install HP
Operations Orchestration Initial Setup section in this guide for more information).

Note: This information is used to set the HP Operations Orchestration properties in the
codar.properties file and import HP Operations Orchestration's certificate into HP Helion
Codar's truststore. Refer to theHP Helion Codar Configuration Guide for more information
about these properties.

21. Enter a location in which to install the embedded HP Operations Orchestration.

22. Enter the database information for the database used by the embedded HP Operations
Orchestration (press Enter after each entry). The database used by the embedded HP Operations
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Orchestrationmust be the same type of database used by HP Helion Codar (Microsoft SQL
Server, Oracle, or PostgreSQL).

a. Enter the database hostname. This is the hostname or IP address of the server where the
embedded HP Operations Orchestration database is located.

b. Enter the database port. This is the embedded HP Operations Orchestration database port
number, such as 1433 (Microsoft SQL Server), 1521 (Oracle), or 5432 (PostgreSQL).

c. Enter the HP OO database name or Oracle HP OOSID. This is the name of the database
instance used by the embedded HP Operations Orchestration. For anOracle database, this is
the System ID (SID).

d. Enter the database user name. This is the user name of the database user you configured for
the HP Operations Orchestration database.

e. Enter the database password. This is the password for the HP Operations Orchestration
database user.

23. Configure an internal HP Operations Orchestration user (select Enter after each entry). This user
is used for provisioning topology designs.

a. Enter the HP Operations Orchestration user name. This is the name of the user used for
provisioning topology designs. This user is given the ADMINISTRATOR and SYSTEM_
ADMIN roles. The recommended user name is admin.

b. Enter the HP Operations Orchestration password. This is the password used by HP
Operations Orchestration for the user who provisions topology designs. The recommended
password is cloud.

24. Review your selections and press Enter to complete the installation orCtrl-C to exit the
installation.

25. When the installation completes, press Enter to exit the installer.

26. If you selected to use the OpenJDK JRE with HP Helion Codar and installed HP Helion Codar on
a system running a headless Ubuntu Linux version 14, install theStandard Java or Java-
compatible Runtime package. Enter the following:

apt-get install default-jre

27. Define the CODAR_HOME and JAVA_HOME environment variables and add /sbin to the PATH
variable for the codaruser user. Set CODAR_HOME to the location where HP Helion Codar is
installed. In a startup script for the codaruser user (for example, .profile (Ubuntu) or .bash_
profile (Red Hat Enterprise Linux)), add the following:

export CODAR_HOME=/usr/local/hp/codar
export JAVA_HOME=$CODAR_JRE_HOME
export PATH=$PATH:/sbin
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where $CODAR_JRE_HOME is the directory where the JRE used by HP Helion Codar is installed.

28. Source the startup file in which you set the CODAR_HOME, JAVA_HOME, and PATH
environment variables. If you edited .bashrc (Ubuntu) or .bash_profile (Red Hat Enterprise
Linux), enter the following:

. ./.bashrc (Ubuntu)

. ./.bash_profile (Red Hat Enterprise Linux)

29. Create an HP Helion Codar service to start and stop the HP Helion Codar processes.

a. Log in as the root user.

b. Go to the directory in which HP Helion Codar is installed. For example:

cd /usr/local/hp/codar

c. Copy the codar script to the /etc/init.d directory. Enter the following:

cp ./scripts/codar /etc/init.d

d. Change permissions of the scripts. Enter the following:

chmod 755 /etc/init.d/codar

e. Log out as the root user.

30. Log in as codaruser and start the HP Helion Codar service. Enter the following:

service codar start

The HP Helion Codar servicemust be running in order to access HP Helion Codar. You can use the
following commands:

service codar start

service codar restart

service codar stop

service codar status
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Post-installation database configuration
The following steps are required for either Oracle or Microsoft SQL Server, after you have installed HP
Helion Codar.

Configure Oracle tablespace
Configure the Oracle tablespace you created for HP Helion Codar only if you are installing HP Helion
Codar for the first time and there is no data in the CSA_DOCUMENT table. The tablespacemust have
been created before HP Helion Codar is installed and thenmust be configured immediately after
HP Helion Codar is installed.

Work with the database administrator to perform the following (or refer to themanufacturer’s
documentation for more information):

Modify the CSA_DOCUMENT table such that LOB segments are stored in the tablespace. For
example:

ALTER TABLE CSA_DOCUMENT
MOVE LOB(content)
STORE AS (TABLESPACE <new_tablespace>);

Configure Microsoft SQL Server filegroup
Configure theMicrosoft SQL server filegroup you created for HP Helion Codar only if you are installing
HP Helion Codar for the first time and there is no data in the CSA_DOCUMENT table. The filegroup
must have been created before HP Helion Codar is installed and thenmust be configured immediately
after HP Helion Codar is installed.

Work with the database administrator to perform the following (or refer to themanufacturer’s
documentation for more information):

1. Drop all constraints from the CSA_DOCUMENT table.

2. Drop the CSA_DOCUMENT table.

3. Recreate the CSA_DOCUMENT table and associate it with the filegroup.

4. Recreate the constraints for the CSA_DOCUMENT table.
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Configure HP Operations Orchestration
The HP Helion Codar solution includes a number of HP Operations Orchestration flows that perform
HP Helion Codar operations.

l If you installed embedded HP Operations Orchestration, see "Configure embedded HP Operations
Orchestration" below.

l If you installed external HP Operations Orchestration, see "Configure external HP Operations
Orchestration" on page 41.

Configure embedded HP Operations Orchestration
Complete the following tasks to configure the embedded HP Operations Orchestration to integrate
successfully with HP Helion Codar (if you are configuring an exclusive stand-alone HP Operations
Orchestration, you do not need to complete these tasks):

l "Add a JRE to the system path" on the next page

l "Configure internal users" on the next page

l "Deploy required content packs" on page 36

l "Verify deployed content packs" on page 37

l "Deploy the HP Operations Orchestration and component tool content packs" on page 38

l "Set up system accounts for the HP Helion Codar content pack" on page 39

l "Set up system properties for the HP Helion Codar content pack" on page 40

Note: In the following instructions, %CODAR_HOME% is the directory in which HP Helion Codar is
installed and %ICONCLUDE_HOME% or $ICONCLUDE_HOME is where you installed HP Operations
Orchestration.

Be sure all the latest patches for HP Operations Orchestration have been installed. See theHP
Helion Codar System and Software Support Matrix for more information, available on the HP
Software Support web site at http://h20230.www2.hp.com/selfsolve/manuals/. This site requires
that you register with HP Passport.
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Add a JRE to the system path
The HP Helion Codar flows that are imported require that a JRE be included in the system path on the
system running HP Helion Codar.

1. Open theEnvironment Variables dialog:

a. Right-click Computer and select Properties.

b. Select Advanced System Settings.

c. Click Environment Variables.

2. Select thePath system variable.

3. Click Edit.

4. At the end of the value forVariable value, add a semicolon (;) and the following path:

$CODAR_JRE_HOME\bin

where $CODAR_JRE_HOME is the folder where the JRE used by HP Helion Codar is installed. .

5. Click OK and close all windows.

Open a shell and enter the following command:

export PATH=$PATH:$CODAR_JRE_HOME/bin

where $CODAR_JRE_HOME is the folder where the JRE used by HP Helion Codar is installed.

Note: By setting the system path, all applications (that require a JRE) use the JRE that is installed
with HP Helion Codar (if it is the only path or the first path set to a JRE in the system path). If you
need to run another JRE with an application, youmust type in the relative path to that JRE in order
to run it (for example, when you configure SSL).

Configure internal users
Internal users can be used to configure HP Operations Orchestration for HP Helion Codar.

1. Log in to HP Operations Orchestration Central.

2. Click theSystem Configuration button.

3. Select Security > Internal Users.
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4. Click Add.

5. Enter the following information:

Field Recommended Value

User Name codaroouser

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

The codaroouser user is used to import the HP Operations Orchestration flows. When importing
flows, this user is configured in the HP Operations Orchestration input file used by the process
definition tool.

6. Click Save.

7. Enable authentication by selecting theEnable Authentication check box.

8. Click OK in the confirmation dialog.

9. Verify that the admin user has been configured. If the admin user is not configured, do the
following:

a. Enter the following information:

Field Recommended value

User Name admin

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

b. Click Save.

c. Enable authentication by selectingEnable Authentication.

d. Click OK in the confirmation dialog.

10. Log out of HP Operations Orchestration Central and log back in as the codaroouser.

Deploy required content packs
There are three sets of content packs that should be deployed for HP Helion Codar: the base HP
Operations Orchestration content packs, the HP Helion Codar component tool content packs, and the
HP Helion Codar content pack.

The base HP Operations Orchestration and HP Helion Codar component tool content packs were
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deployed automatically when you installed HP Helion Codar. If these content packs failed to deploy
during installation, youmust deploy themmanually.

The HP Helion Codar content pack MUST bemanually deployed. The HP Helion Codar content pack
must be deployed after the base HP Operations Orchestration content packs have been deployed.

Verify deployed content packs
To verify that the HP Operations Orchestration and component tool content packs were successfully
deployed during installation, do the following:

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Click theContent Packs tab.

4. Look for the names and versions of content packs in the list. If a content pack is missing, follow
the instructions below tomanually deploy it.

The content packs that should have been automatically deployed are:

n CSA-VMWARE

n CSA-SITESCOPE

n CSA-SA

n CSA-HP-HELION-PUBLIC-CLOUD

n CSA-HP-CONFIG

n CSA-CHEF

n CSA-AMAZON

n SM

n SA

n Virtualization

n HP Solutions

n Cloud

n Base

n EXISTING-INFRASTRUCTURE

n CSA-Docker
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Deploy the HP Operations Orchestration and component
tool content packs
If one or more of the base HP Operations Orchestration or HP Helion Codar component tool content
packs are not deployed, youmust deploy themmanually:

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Click theContent Packs tab.

4. From HP Operations Orchestration Central, click theContent Management button.

5. Click theContent Packs tab.

6. Click theDeploy New Content icon.

7. In the Deploy New Content dialog, click theAdd files for deployment icon.

8. Navigate to the %CODAR_HOME%/oo/OOContentPack/ directory. From the subdirectories, select a
content pack and click Open thenDeploy. Select, open, and deploy the following base content
packs in the order shown below:

n oo10-base-cp-1.1.1

n oo10-cloud-cp-1.1.0

n oo10-hp-solutions-cp-1.1.2

n oo10-virtualization-cp-1.1.0

n oo10-sa-cp-1.0.2

n oo10-sm-cp-1.0.1

Note: Do not deploy the HP Helion Codar content pack until after you have deployed the base
content packs. The HP Helion Codar content pack must be deployed separately and after you
have deployed the base content packs.

The deployment may take a few minutes and the dialog will show a progress bar.

When the deployment succeeds, click Close to close the dialog.

9. Click theDeploy New Content icon.

10. Click theAdd files for deployment icon.
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11. Navigate to the %CODAR_HOME%/Tools/ComponentTool/contentpacks/ folder, select all the
content packs, and click Open.

12. Click Deploy.

The deployment may take a few minutes and the dialog will show a progress bar.

13. When the deployment succeeds, click Close to close the dialog.

Deploy the HP Helion Codar content pack
The HP Helion Codar content pack must be deployed after you have deployed the HP Operations
Orchestration content packs.

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Click theContent Packs tab.

4. Click theDeploy New Content icon.

5. Click theAdd files for deployment icon.

6. Navigate to the %CODAR_HOME%\CSAKit-4.2\OO Flow Content\10X directory and select the
following content packs:
n CODAR-cp-1.00.0000.jar

n CSA-HPOO-cp-4.20.0000.jar

n oo10-csa-cp-4.20.0000.jar

7. Click Open.

8. Click Deploy.

The deployment may take a few minutes and the dialog will show a progress bar.

9. When the deployment succeeds, click Close to close the dialog.

Set up system accounts for the HP Helion Codar content
pack
Set up system accounts for the HP Helion Codar content pack:
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1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Select Configuration Items > System Accounts.

4. Click theAdd icon.

5. Enter the following information if it is not already configured:

Field Recommended value

System Account Name CODAR_REST_CREDENTIALS

User Name ooInboundUser

Password cloud

Note: TheUser Name configured for the CODAR_REST_CREDENTIALS System Account
settingmust match theProperty Value (HP Operations Orchestration version 9.07) or
Override Value(HP Operations Orchestration version 10.20) configured for the CODAR_
OO_USER System Property setting.

6. Click Save.

Set up system properties for the HP Helion Codar content
pack
Set up the following system properties for the HP Helion Codar content pack:

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Select Configuration Items > System Properties.

4. Click theAdd icon.

5. Enter the following information if it is not already configured:

Field Recommended Value

Name CODAR_REST_URI

Override Value https://<codar_hostname>:8444/csa/rest

6. Click Save.
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Configure external HP Operations Orchestration
Complete the following tasks to configure HP Operations Orchestration to integrate with HP Helion
Codar:

l "Add a JRE to the system path" below

l "Install the HP Helion Codar content packs" on the next page

l "Configure internal users" on page 43

l "Deploy content packs required by HP Helion Codar" on page 44

l "Set up system accounts for the HP Helion Codar content pack" on page 45

l "Set up system properties for the HP Helion Codar content pack" on page 46

Note: In the following instructions, %CODAR_HOME% is the directory in which HP Helion Codar is
installed and %ICONCLUDE_HOME% or $ICONCLUDE_HOME is where you installed HP Operations
Orchestration.

Be sure all the latest patches for HP Operations Orchestration have been installed. See theHP
Helion Codar System and Software Support Matrix for more information, available on the HP
Software Support web site at http://h20230.www2.hp.com/selfsolve/manuals/. This site requires
that you register with HP Passport.

Add a JRE to the system path
The HP Helion Codar flows that are imported require that a JRE be included in the system path on the
system running HP Helion Codar.

ForWindows:

1. Open theEnvironment Variables dialog:

a. Right-click Computer and select Properties.

b. Select Advanced System Settings.

c. Click Environment Variables.

2. Select thePath system variable.

3. Click Edit.
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4. At the end of the value forVariable value, add a semicolon (;) and the following path:

If HP Operations Orchestration and HP Helion Codar are installed on the same system:

%ICONCLUDE_HOME%\java\bin

or

If HP Operations Orchestration and HP Helion Codar are installed on different systems:

<codar_jre>\bin

5. Click OK and close all windows.

For Linux:

Open a shell and enter the following command:

If HP Operations Orchestration and HP Helion Codar are installed on the same system:

export PATH=$PATH:$ICONCLUDE_HOME/java/bin

or

If HP Operations Orchestration and HP Helion Codar are installed on different systems:

export PATH=$PATH:$CODAR_JRE_HOME/bin

Note: By setting the system path, all applications (that require a JRE) use the JRE that is installed
with HP Operations Orchestration or HP Helion Codar (depending on the path you configured and if
it is the only path or the first path set to a JRE in the system path). If you need to run another JRE
with an application, youmust type in the relative path to that JRE in order to run it (for example,
when you configure SSL).

Install the HP Helion Codar content packs

l Copy the%CODAR_HOME%\OO Flow Content\10X\oo10-csa-cp-4.20.0000-uuids.txt file to:

Windows
%ICONCLUDE_HOME%\central\cmu\exclusions

Linux
$ICONCLUDE_HOME/central/cmu/exclusions

l If HP Helion Codar and HP Operations Orchestration are running on different systems, copy the
following content packs from%CODAR_HOME%\OO Flow Content\10X\ on the HP Helion Codar
system to the HP Operations Orchestration system, where %CODAR_HOME% is the directory in which
HP Helion Codar is installed:
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n CODAR-cp-1.00.0000.jar

n CSA-HPOO-cp-4.20.0000.jar

n oo10-csa-cp-4.20.0000.jar

Configure internal users
Internal users can be used to configure HP Operations Orchestration for HP Helion Codar.

1. Log in to HP Operations Orchestration Central.

2. Click theSystem Configuration button.

3. Select Security > Internal Users.

4. Click theAdd button.

5. Enter the following information:

Field Recommended value

User Name codaroouser

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

The codaroouser user is used to import the HP Operations Orchestration flows. When importing
flows, this user is configured in the HP Operations Orchestration input file used by the process
definition tool.

6. Click Save.

7. Enable authentication by selecting theEnable Authentication check box.

8. Select OK in the confirmation dialog.

9. Enter the following information:

Field Recommended value

User Name admin

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN
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10. Click Save.

11. Enable authentication by selectingEnable Authentication.

12. Click OK in the confirmation dialog.

13. Log out of HP Operations Orchestration Central and log back in as the codaroouser.

1. Log in to HP Operations Orchestration Central.

2. Click theSystem Configuration button.

3. Select Security > Internal Users.

4. Click theAdd button.

5. Enter the following information:

Field Recommended Value

User Name codaroouser

Password cloud

Roles ADMINISTRATOR, SYSTEM_ADMIN

The codaroouser user is used to import the HP Operations Orchestration flows. When importing
flows, this user is configured in the HP Operations Orchestration input file used by the process
definition tool.

6. Click Save.

7. Enable authentication by selecting theEnable Authentication check box.

8. Select OK in the confirmation dialog.

9. Log out of HP Operations Orchestration Central and log back in as the codaroouser.

Deploy content packs required by HP Helion Codar

The HP Helion Codar content packs must be deployed after you have deployed the base HP
Operations Orchestration content packs.

1. From HP Operations Orchestration Central, click theContent Management button.

2. Click theContent Packs tab.

3. Click theDeploy New Content icon.
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4. In the Deploy New Content dialog, click theAdd files for deployment icon.

5. Click theDeploy New Content icon.

6. Click theAdd files for deployment icon.

7. Navigate to the %CODAR_HOME%\CSAKit-4.2\OO Flow Content\ 10X directory and select the
following content packs:
n CODAR-cp-1.00.0000.jar

n CSA-HPOO-cp-4.20.0000.jar

n oo10-csa-cp-4.20.0000.jar

8. Click Open.

9. Click Deploy.

The deployment may take a few minutes and the dialog will show a progress bar.

10. When the deployment succeeds, click Close to close the dialog.

Set up system accounts for the HP Helion Codar content
pack
Set up system accounts for the HP Helion Codar content pack:

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Select Configuration Items > System Accounts.

4. Click theAdd icon.

5. Enter the following information if it is not already configured:

Field Recommended value

System Account Name CODAR_REST_CREDENTIALS

User Name ooInboundUser

Password cloud
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Note: TheUser Name configured for the CODAR_REST_CREDENTIALS System Account
settingmust match theProperty Value (HP Operations Orchestration version 9.07) or
Override Value(HP Operations Orchestration version 10.20) configured for the CODAR_
OO_USER System Property setting.

6. Click Save.

Set up system properties for the HP Helion Codar content
pack
Set up the following system properties for the HP Helion Codar content pack:

1. Log in to HP Operations Orchestration Central.

2. Click theContent Management button.

3. Select Configuration Items > System Properties.

4. Click theAdd icon.

5. Enter the following information if it is not already configured:

Field Recommended Value

Name CODAR_REST_URI

Override Value https://<codar_hostname>:8444/csa/rest

6. Click Save.
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Install VMware vCenter
Install vCenter according to themanufacturer's recommendations. For example, follow the VMware
best practices for managing individual ESX servers from a vCenter instance. You can find the VMware
documentation at http://www.vmware.com/support/pubs/.

Youmust have a vCenter instance that can support the flows that actuate vSphere VMs. SeeHP
Helion Codar System and Software Support Matrix for version requirements.

Both theHP Helion Codar Management Console Help, which is available in a printable PDF format,
and theHP Helion Codar System and Software Support Matrix are available on the HP Software
Support web site at http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you
register with HP Passport.
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Install HP Server Automation
Install HP Server Automation to the correct version and patch level. SeeHP Helion Codar System and
Software Support Matrix for version requirements.

You can determine your version and patch level by using the HP Server Automation Client and
selectingHelp > About.

Installation notes:

l You can use the DHCP services included with HP Server Automation. For information on
configuring a DHCP server with HP Server Automation, seeHP Server Automation
Simple/Advanced Installation Guide.

l The HP Server Automation Client should be installed on the HP Operations Orchestration server.

l The HP Server Automation Client does not register right away after installation. A delay occurs
before you can continue with configuration.

HP software product documentation is available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Configure HP Server Automation
The following tasks are required to configure HP Server Automation to allow read and write access to
the required areas:

l "Create the HP Helion Codar service account" below

l "Create the HP Helion Codar administrators group and assign permissions" on the next page

l "Validate the Helion Codar service account" on page 50

l "Validate the HP Server Automation client" on page 51

Create the HP Helion Codar service account

1. Open the HP Server AutomationWebClient in a browser.

2. Log in using the HP Server Automation Administrator user name and password (created when the
HP Server Automation server was installed).

3. Click Administration > Users & Groups.
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4. Click New User in the Users tab toolbar and complete the following fields using the values listed
in the following table:

Field Name Value

Last Name Service Account

First Name CSA

Full Name CSA Service Account

Email Address <your email address>

User Name hpcsa

Password <password>

5. Select Superusers from theGroupMembership list to enable this option.

6. Click Save.

7. Click Log Out.

Create the HP Helion Codar administrators group and
assign permissions

1. Open the HP Server AutomationWebClient in a browser.

2. Log in using the HP Server Automation Administrator user name and password.

3. Click Administration > Users & Groups.

4. Select theGroups tab.

5. Click New Group and complete the following fields using the values listed in the following table:

Field Name Value

Group Name hpcsa-admin

Group Description HPCSA Administrators

Not Assigned Read & Write

Opsware Read

6. Click Save.

Installation and Configuration Guide
Install HP Server Automation

HP Helion Codar (1.00) Page 49 of 72



7. Select hpsca-admin in the list of groups.

8. Select theUsers tab and add the admin and hpcsa users to the hpcsa-admin group.

9. Click Save.

10. Select the Facilities tab and select Read & Write to the appropriate facility.

If only one facility exists, select Read & Write for it.

11. Click Save.

12. Select the Features tab and click Select All in the header row to select all features.

13. Click Save.

14. Select theClient Features tab and change all values toRead & Write andYeswhere applicable.

15. Click Save.

16. Select theOther tab and select all options except Generate Security Reports.

17. Click Save.

18. Select theOGFS Permissions tab, click Add Permissions, and enter the following permissions:

n Features: Select Run Command on Server.

n Servers: Click theCustomers option and select Not Assigned from the list.

n Login Names: Select Opsware user name, and select Log in as and enter root.

19. Click Grant.

20. Click Add Permissions and enter the following permissions:

n Features: Select Launch Global Shell.

21. Click Grant.

22. Click Log Out.

Validate the Helion Codar service account

1. Open the HP Server AutomationWebClient in a browser and verify that the login screen appears.

2. Log in using the Helion Codar Service Account credentials you created in the previous steps.

Installation and Configuration Guide
Install HP Server Automation

HP Helion Codar (1.00) Page 50 of 72



3. Verify that the HP Server AutomationWebClient home page is displayed. A list of tasks and jobs
is shown.

4. Click theManaged Servers option on the left side of the screen and verify that a list of servers
with their IP addresses and operating system information is displayed.

5. Click Log Out and close theWeb browser.

Validate the HP Server Automation client

1. Connect to the system where HP Operations Orchestration is installed.

2. Verify that the client is installed.

n If an icon appears on the desktop labeled HP Server Automation Client or a link appears in the
Start Menu, the client is installed. Continue to step 3.

n If neither the icon nor the Start Menu link appear, then you need to install the client by
performing the following steps:

i. Open the HP Server AutomationWebClient in a browser and select Download
Opsware Launcher at the login screen.

ii. Install the client using the default parameters.

Youmust have a JRE installed in order to use the Opsware Launcher on aWindows system.

3. Launch the client with the following credentials:

n Username: hpcsa

n Password: <hpcsa password>

n Core Server: <SA Server Host Name>

The above login informationmay vary depending on your installation.

4. Verify that the HP Server Automation application starts and Device Groups appear in the left hand
navigation pane.

5. Click All Managed Servers and verify that a list of servers with their names, IP addresses, and
operating system information is displayed.

6. Exit the client.

Prepare VMware template
These steps prepare a VMware template to self-register with HP Server Automation.
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Virtual machines (VMs) created by the HP Helion Codar solution are created based on virtual machine
templates. The HP Helion Codar flows reference a vSphere template name, and perform a clone
operation to provision new virtual machines. These templates would generally provide an operating
system image only, with no application software installed.

To allow applications (such as Apache) to be deployed to the image, youmust install and configure HP
Server Automation and create a template that includes the HP Server Automation Agent software. That
is, in order to manage the virtual server and to install application software, the clones are configured to
self-register upon power-on with an HP Server Automation system. Once registered as amanaged
server, software policies are applied to the server in order to install and configure the correct
applications. Refer to theHP Server Automation Policy Setter Guide and theHP Server Automation
Application Deployment User Guide in the HP Server Automation documentation for more information
onmanaging servers and configuring software policies. HP software product documentation is
available on the HP Software Support web site at http://h20230.www2.hp.com/selfsolve/manuals/.
This site requires that you register with HP Passport.

Template preparation overview
For cloned virtual machines to register with the HP Server Automation system upon power-on, prepare
a template with an HP Server Automation agent. The following is a general outline of the steps to be
performed:

l First, create a virtual machine with the appropriate operating system image that you would like to
template. Provision the VM with an operating system through any method supported by vSphere:

n Manually install the operating system on a prepared, configured VM.

n Provision the operating system through a network boot operation from the HP Server Automation
system.

Refer to the appropriate vSphere documentation to create a new virtual machine with an installed
operating system image.

l When preparing a virtual machine as a template to be used to clonemany new virtual machines,
leave the configuration as generic as possible. No hostname can be configured, and the network
configuration can be obtained via DHCP.

l Install and test the appropriate VMware Tools on the virtual machine.

l Install the HP Server Automation agent. The agent registers the template with the HP Server
Automation system so that this machine is in aManaged state for the next step.

l An APX utility in the HP Server Automation system library is run to prepare the agent on the virtual
machine to re-install and register with the HP Server Automation system on the next bootup.

l The virtual machine is shut down and converted to a template.

l Delete the virtual machine server record from the HP Server Automation system.
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Detailed process
Refer to the vSphere documentation set for detailed information on the creation, configuration, and
operating system installation for a new virtual machine. There are several options to install an operating
system onto a new virtual machine. One of the options available is to use the PXE network boot facility
from the HP Server Automation server, with an operating system installation profile that integrates the
installation of an HP Server Automation agent. A virtual machine which is provisioned using this
method starts the agent upon bootup, and attempts to register it with the HP Server Automation
system.

If you use another method to provision an operating system on the virtual machine, the HP Server
Automation agent can be installed from the HP Server Automation system. You can refer to the product
documentation for an expanded discussion of this process; the following instructions describe one
method.

Provision an operating system on a virtual machine

1. Boot the virtual machine andmake sure that it is connected to the network. Verify that the HP
Server Automation (HP SA) system can be reached.

2. Discover the virtual machine in theUnmanaged Servers (HP SA 9.x) orSA Agent Installation
(HP SA 10.x) window in HP Server Automation. You can scan an entire subnet or enter the IP
address for the virtual machine and initiate a scan to discover it.

3. Select the virtual machine, right-click, and then selectManage Server (HP SA 9.x) or Install SA
Agent (HP SA 10.x). A new dialog opens.

4. Provide the appropriate login credentials, and select the action to verify prerequisites, copy
installer, and install the agent. Set any desired Installer Options at this time, referring to the HP
Server Automation documentation for details.

5. Click OK.

When the installation process completes successfully, the agent is installed, and the virtual
machine is visible in theAll Managed Servers tab. The hostname has not been set, as we plan to
convert this virtual machine to a generic template. So, the default host name is used for the virtual
machine.

6. From theServer Information Properties tab, select the virtual machine and press Enter.

7. Select Properties.

8. Record theObject ID of the virtual machine, which can be found in theManagement Information
section of the Properties panel.
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Sanitize the agent configuration on a template machine
The agent on our virtual machine templatemust be prepared to install and register a new machine
server with HP Server Automation each time we create a new clone. To prepare the agent wemust
sanitize the agent configuration on our templatemachine by doing the following:

1. Switch to the Library tab in the HP Server Automation client.

2. Expand theExtensions folder.

3. Select Program.

4. Locate theBRDC HPSA agent sanitizer Automation Platform Extension (APX).

5. Execute the BRDC HPSA agent sanitizer APX:

a. Right-click the APX and select Run.

b. Select theOptions tab in the Run Program Extensions dialog.

c. In theSpecify any needed parameters for this program execution field, enter theObject
ID, which you previously obtained for the virtual server template:

d. Click Start Job.
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e. Shut down the virtual machine after the job completes successfully and the agent has been
prepared.

Do not reboot this virtual machine again until after it has been converted to a vSphere
template.

f. Using the vSphere client, convert this virtual machine to a template.

g. The last step is to clean up the server records for the virtual machine template from HP Server
Automation. In the All Managed Servers tab:
i. Deactivate the server.

ii. Delete the server.

The template is now ready to use to clone new virtual machines. HP Helion Codar uses a simple
customization template that sets the hostname equal to the VM name. Additional customization is
possible during the clone operation. See theBasic Customization section below.

When a newly cloned virtual machine powers up, the HP Server Automation Agent installs and then
contacts the HP Server Automation system to self-register. Shortly after power on, you can refresh the
All Managed Servers view in the HP Server Automation client to locate the new virtual machine record.

Basic customization
Perform the following basic customizations:

1. On the vCenter environment click View >Management > Customization Specifications
Manager.

2. Click theNew icon.

3. Select Windows or Linux for your Target Virtual Machine OS. You can create one of each.

4. If you are creating aWindows target, name it useVmName_Windows. If you are creating a Unix
target, name it useVmName_Linux.

5. Customize as appropriate, noting two important items:

n On the screen with the NetBIOS Name youmust chooseUse the virtual machine name.

n If the virtual machine name exceeds 15 characters, it will be truncated.

Install the prepared template
The templatemust be installed on the system containing the vSphere client software. SeeConfigure
VMware vCenter for more information.

Consult the vSphere documentation for additional details. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.
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Configure VMware vCenter
Configure VMware vCenter by installing prepared templates. In the vSphere environment, a template is
amaster copy of a virtual machine that can be used to createmany clones. A clone is a copy of a
virtual machine.

You can learnmore about creating templates and working with clones in vSphere by referring to
VMware's vSphere Virtual Machine Administration Guide for vCenter Server (EN-000312-02), available
in the VMware documentation. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.

Virtual machines created by the HP Helion Codar solution are created based on virtual machine
templates. To allow applications (such as Apache) to be deployed to the image, youmust create a
template that includes HP Server Automation Agent software. SeePrepare a VMware Template to
Self-Register with HP Server Automation for more information.

To install a prepared template, do the following:

1. Locate a prepared template.

2. Copy the template folder to the system containing the vSphere client software.

3. From your vSphere client softwaremenu, select View > Inventory > Datastores to see a list of
available datastores on your vCenter server.

4. Right-click one of the available datastores and select Browse Datastore to see the directory
structure of that datastore.

5. Copy the template folder to the datastore by clicking on theUpload files to this datastore
button.

The following image shows the Datastore Browser window withUpload files to this datastore
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highlighted. It also shows a rhel53x64-clone folder that was uploaded to this datastore:

Consult the vSphere documentation for additional details. You can find the VMware documentation at
http://www.vmware.com/support/pubs/.
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Install HP SiteScope
Install HP SiteScope to the correct version and patch level. SeeHP Helion Codar System and
Software Support Matrix for version requirements.

Installation notes:

l Do not install HP SiteScope on the HP Operations Orchestration server. It must be on its own
server.

l Calculate the resources needed for the HP SiteScope server using the information in the HP
SiteScope documentation. This calculation should include the number of target servers that you
expect Helion Codar to monitor.

l During installation, you can change the port for the HP SiteScope service to avoid potential
conflicts with other web servers that use the default port value of 8080. Select any available port on
the system and keep track of the port number that you select.

HP software product documentation is available on the HP Software Support web site at
http://h20230.www2.hp.com/selfsolve/manuals/. This site requires that you register with HP Passport.

Configure HP SiteScope
The following tasks are required to configure HP SiteScope to integrate successfully with HP Helion
Codar:

l "Enable HP Helion Codar to configure HP SiteScopemonitors" below

l "Auto-deploy the HP Helion Codar templates and credential profiles" on the next page

l "Manually import additional HP Helion Codar templates" on the next page

l "Configure HP Helion Codar credential profiles" on page 60

l "Configure HP SiteScope administrator credentials" on page 60

Enable HP Helion Codar to configure HP SiteScope
monitors
HP SiteScope is installed with a default of secured API calls required for configuringmonitors. HP
Helion Codar does not support secured API calls; therefore, youmust change this setting. To re-
configure HP SiteScope so it does not use secure APIs, youmust make the following change to the
configuration:
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1. Stop the HP SiteScope service by typing the following command in a console window:

net stop SiteScope

2. Open the HP SiteScope <sitescopeInstallDir>\groups\master.config file in a text editor.

3. Change the _accessControlled=true property value to _accessControlled=false.

4. Restart the HP SiteScope service by typing the following command in a console window:

net start SiteScope

Auto-deploy the HP Helion Codar templates and
credential profiles
1. Log in to the HP SiteScope server as Administrator.

2. Log in to the HP Helion Codar server.

3. From the HP Helion Codar server, copy the %CODAR_HOME%\CSAKit-4.2\Lib\sitescope\CSA
templates autoimport.tmpl file to the <sitescopeInstallDir>\persistency\import
directory on the HP SiteScope server. When the CSA templates autoimport.tmpl file is
processed, HP SiteScope creates a template container (CSA templates) and two credential
profiles (WINDOWS-CSA-TARGETS and LINUX-CSA-TARGETS).

4. Log in to the HP SiteScope Dashboard.

5. Select the Templates context. In the template tree, look for the CSA templates container. You
must wait for the HP SiteScope server to finish processing the
CSA templates autoimport.tmpl file before the CSA templates template container is
displayed.

6. Select Preferences context > Credential Preferences and look for the WINDOWS-CSA-TARGETS
and LINUX-CSA-TARGETS credential profiles, which you will configure in Step 4: Configure
HP Helion Codar Credential Profiles.

Manually import additional HP Helion Codar templates
Two additional HP Helion Codar templates, CSA templates Silver and CSA templates Gold, must
bemanually imported. These templates are used by the CSA_BP_VCENTER_COMPUTE_
SITESCOPE_MODIFY_v1.00.00 service design.

Installation and Configuration Guide
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1. Log in to the HP SiteScope Dashboard.

Note: Youmust be able to access files in the %CODAR_HOME%\CSAKit-4.2\Lib\sitescope
directory from the HP SiteScope Dashboard. If necessary, copy this directory to the system
from which you are launching the HP SiteScope Dashboard.

2. Select the Templates context.

3. In the template tree, right-click SiteScope and select Import.

4. Browse to %CODAR_HOME%\CSAKit-4.2\Lib\sitescope (or the directory to which this directory
was copied) and import CSA templates Silver.tmpl.

5. Repeat steps 3 and 4, but import CSA templates Gold.tmpl.

Configure HP Helion Codar credential profiles
Configure the credentials used to log in to every Windows system and every Linux systemmonitored
by HP SiteScope. The credentials to all Windows systems must be the same. Likewise, the
credentials to all Linux systems must be the same.

1. Log in to the HP SiteScope Dashboard.

2. Select Preferences context > Credential Preferences.

3. Edit the LINUX-CSA-TARGETS credential profile and supply login credentials for your Linux
environment.

4. Edit theWINDOWS-CSA-TARGETS credential profile and supply login credentials for your
Windows environment.

Configure HP SiteScope administrator credentials
Configure the credentials used to log in as the administrator of HP SiteScope. These credentials are
used by HP Helion Codar when configuring HP SiteScope resource providers from theManagement
Console.

1. Log in to the HP SiteScope Dashboard.

2. Select Preferences context > User Management Preferences.

3. Right-click SiteScope Administrator and select Edit User.

4. If not already specified, enter a login name and password for the HP SiteScope administrator.

Installation and Configuration Guide
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Configure resource providers
HP recommends that you follow this procedure to create two resource providers. These resource
providers should be associated with two different data centers which are associated with two different
environments, likely namedDevelopment and Testing.

To configure a resource provider,

1. Open HP Helion Codar at https://<ipadress>:<port>/csa

Where <ipadress> is the IP address or host name of the HP Helion Codar server, and <port> is
the port number, which is 8444 by default.

2. Log in as the administrator. The default user name is admin and the default password is cloud.

3. Click the Providers tile.

4. Under All Providers on the left, select the provider type that will be used for application
deployment.

5. Click Create and enter details for the resource provider you will use for application deployment.

6. After the provider has been created, select the Properties tab and provide the values for the
properties that are defined for the provider type.

For example, if the provider chosen is the vCenter provider, youmight create a property named
DATACENTERNAME with the value DEVELOPMENT.

7. Return to themain Providers screen and choose By Environment in the drop-down field in the
upper right corner of the screen.

8. Click Create your first Resource Environment.

9. Enter details for the resource environment.

The resource environment you enter here should be the same as the Environment you entered in
Configure the plug-in.

10. Click Select Resource Providers.

11. Add the provider you created and then click Save.
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Apply HP Helion Codar licenses
After installation in complete, apply a HP Helion Codar permanent license. You can then apply a HP
Cloud Service Automation permanent license, if desired. After a HP Cloud Service Automation license
is installed, you would be able to use all of HP Helion Codar and HP Cloud Service Automation
features.

The following license types are available:

l HP Helion Codar permanent license only.

l HP Cloud Service Automation permanent license only.

If you install HP Cloud Service Automation, then youmust add an HP Cloud Service Automation
license first; if you install HP Helion Codar, then youmust install an HP Helion Codar license first.

OSI capacity
The number of operating systems you can use in active applications or subscriptions is known as the
OSI capacity. If you have HP Cloud Service Automation and HP Helion Codar licenses, then the OSI
capacity is the lowest of the two. Here’s an example: I have an HP Cloud Service Automation license
with 100OSI and an HP Helion Codar license with 50OSI, somy OSI capacity is 50.
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Jenkins
Jenkins is optional, but youmust install Jenkins and dependencies if you intend to use the sample
design, and it is required for .

You should consult product documentation for installation and usage instructions.

Using Jenkins with HP Helion Codar requires the following dependencies:

l Collabnet Subversion Edge: collab.net/support/documentation

l TortoiseSVN: tortoisesvn.net/support.html

l Maven: maven.apache.org/guides/index.html

l Jenkins: jenkins-ci.org/

Install the JDK
Install the JDK version 1.7x on the Jenkins server.

Install Collabnet Subversion Edge
Download and install a version appropriate to your system from collab.net/downloads/subversion.

Install Tortoise
Download and install the latest version from tortoisesvn.net. Use the default settings.

After installation, you will see new options when you right-click a file or folder inWindows Explorer.

Install the Maven plugin
Download and install Maven frommaven.apache.org.

The following steps are for Jenkins version 1.583:

1. Make sure the JDK andMaven are installed.

2. Go to the Jenkins URL.
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3. Click Manage Jenkins.

4. Click Configure System.

5. In the JDK section, click Add JDK.

6. Enter the name and path for JAVA_HOME.

7. Deselect Install automatically.

8. In theMaven section, click Add Maven.

9. Enter the name and path for MAVEN_HOME.

10. Deselect Install automatically.

11. Enter the value for MAVEN_OPTS.

12. Click Save.

Install Jenkins
Download theWindows installer for Jenkins from jenkins-ci.org.

After installation, you should access the Jenkins server at http://localhost:8080 to validate the
installation.

Install the HP Helion Codar Jenkins plug-in
1. Log in to the Jenkins Dashboard in a browser at http://<host>:<port>/, substituting the host and

port information appropriate for your Jenkins environment.

2. Click Manage Jenkins from the Dashboard

3. Click theManage Plugins.

4. Select the Advanced tab.

5. In the Upload Plugin section, browse to select the following file:

Hewlett-Packard\Codar\CSAKit-4.2\Content Archives\topology\Jenkins plugin\HP_Helion_
Codar.hpi

6. Click Upload.

7. Select the Installed tab and verify that the HP Helion Codar plug-in was installed.
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Enable the plug-in

1. Click Manage Jenkins from the Dashboard.

2. Click Configure System.

3. Scroll down to the HP Codar Application Deployment section of the Configure System page and
select theEnable checkbox.

4. Click Save.

Configure the Pet Clinic sample application project

1. Check in the source code for the Pet Clinic project into the SVN server.

You can download the PetClinic folder from the HP Helion Codar FTP site. See Downloading HP
Helion Codar for information on how to access the site. The file is in the HP Helion CODAR Beta
1.0.0\Content\4_Sample_Content_Source_Code directory at the FTP site.

2. Create a new PetClinic project in the Jenkins server using optionBuild a maven2/3 project.

3. Click thePetClinic link on the Jenkins Dashboard, and then click theConfigure link on the page
that opens.

4. Configure SVN for Source CodeManagement for the PetClinic project by choosing the
Subversion Modules option and adding the SVN PetClinic source code URL in the Repository
URL field.

5. After saving, update the SVN credentials like this:
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6. Configure Jenkins to automatically trigger a build if any code is checked-in by selecting thePoll
SCM checkbox and adding */5 * * * * as the schedule.

7. 6. Scroll down to and click Add post-build action, select Archive the artifacts, and then enter
*/*.war, target/classes/*/*.sh in the Files to archive text box.

Configure the plug-in for the Pet Clinic sample application
Configure the plugin for Pet Clinic projects:

1. Click the PetClinic link on the Jenkins Dashboard, and then click the Configure link on the page
that appears.

2. Click Add post build action and select HP Codar Plugin.

3. Enter the HP Helion Codar plug-in properties as is applicable:

n HostName – The host name or IP address of the server on which HP Helion Codar is installed.

n Port – The port number on which the HP Helion Codar application is listening.

n Username – The name of a user that has HP Helion Codar administrative privileges.

n Password – The password for the HP Helion Codar user.

Caution: Do not use the default HP Helion Codar admin user because this might be a
security issue. After installing Codar and configuring LDAP, add a user to the Application
Architect role. Use the credentials for that user here.

n Application Design Location – The relative path and file name, from the source repository URL,
of the application design JSON file for the application to be deployed by HP Helion Codar (for
example, designs\PetClinicApp.json).

Note: See Access REST APIs for steps to get the JSON using REST APIs that will be
checked into the Application Design Location as files.

n Environment – The environment in HP Helion Codar in which the provider that is to be used for
deployment is contained.
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Note: The environment value is mandatory if you want to use HP Helion Codar for continuous
deployment.

n Package properties – Specify the component properties of the design that will be
parameterized within the Build. The input to this field should be specified in the format
component1id:property1id:property1value,component1id:property2id:property2value,compone
nt2id:property3id:property3value where

o componentxid – The id of the component in the application design. This can be obtained
from the Application design Json's file.For e.g for a Petclinic application component it could
be : PetClinic_Application__VERSION__1__GROUPID__com.hp.csa.type0001.

o propertyxid – The id of the property within the component. This can be obtained from the
Application design Json's file.For e.g for a artifacturl property within Petclinic application it
could be : artifacturl_a36 .

o propertyxvalue – The value of the property that need to be parameterized.If its a jenkins
build output artiact the url of the artifact will be automatically computed and value will
represent the complete http url from which this artifact can be downloaded. For e.g to
specify the Jenkins build artifact for petclinic it could be : petclinic.war.

o For example: PetClinic_Application__VERSION__1__GROUPID__
com.hp.csa.type0001:artifacturl_a36:petclinic.war

n Extended Properties File – Optionally enter the name of the properties file. This property need
to be specified only when the user wants to specify a different CI process than what is provided
by default. This properties file can specify a different OO flow containing necessary CI logic .
User can specify a different flow id by creating a property file with key as uuid and value as the
uuid of OO flow. For example, uuid=asdaasdasdsdasdad99f.

You can also specify the required properties to this flow as key value pairs in this property file.

n NodeId – Enter the component ID for which you want to extract component properties. These
component ids can be obtained from the Application design JSON file which has been
exported. Multiple components are specified by seperating those with comma.

For example, youmay want to retrieve an IP address and host name of the VCenter component
(VcenterServerType__VERSION__04.20.0000__GROUPID__com.hp.csa.type0002) to run
tests on the provisioned server

n Httpusername – Enter the user name for accessing artifacts from HTTP location. For ex it can
be username of Jenkins Server

n HttpPassword – Enter the password for accessing artifacts from HTTP location. For ex it can
be password of Jenkins Server

n SSLCertificatePath – Enter SSLCertificate Path for Codar and pickup the certificate from
CODAR setup. It will be in themachine where Codar is installed in the path - \Hewlett-
Packard\Codar\IA-openjre\lib\security\cacerts
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n CertificatePassword – Enter SSLCertificate Keystore Password for Codar. By default it is
"changeit"

Sample Pet Clinic extended properties file
This has to be changed to following

## Properties accessed by the ARA API to invoke OO flows.

##This properties file contains the oo flow id(uuid) as well as the relevant
parameters to be passed to the oo flow.

##Dynamic properties can be specified by <<propert>> prefixing and suffixing
with angular brackets. These properties

## will be substituted with the value passed in JSON input.

csaTruststore=C:/codar/cacerts

#uuid of the oo flow. This flow contains the necessary logic for the Continuous
integration process.

#uuid=377898bc-d92e-4e6a-b542-718539fdcb9a

#Specify the artifacts that are built by jenkins to manage it within ARA. These
artifacts would be dynamically obtained from jenkins and deployed via ARA.

##Format is
component1id:property1id:property1value,component1id:property2id:property2value,
component2id:property3id:property3value where

##where COMPONENT1id - represents the id of the component as displayed in the
design

## property1id - represents the property of the component which needs to be
dynamically replaced

##property1value - will represent the artifacts which need to be deployed.

##Sample

##Pet_Clinic_DB_Configuration_87424824_fdfd_485d_b392_7e5b58cadb1a_
320fb4ee61694fd9a4ea347537d08fcb__VERSION__1__GROUPID__com.hp.csa.type.VMWARE_
VCENTER0001:artifacturl:petclinic.war

#The server node which needs to be queried for obtaining ip address. This is
relevant for Continuous Delivery where tests can be run against the provisoned
virtual machine via ip address.

#serverNodeId=VcenterServerType__VERSION__04.10.00000002

#componentid:propertyname:jenkinsout,componentid:propertyname:jenkinsout
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Create a custom design
You can configure continuous deployment for custom applications by creating custom HP Operations
Orchestration flows.

If a custom application in an enterprise needs continuous deployment users can create deployment
scripts using Chef or HP Operations Orchestration. Those flows can be embraced (imported) as
components in HP Helion Codar and used in the creation of an application design, which can then be
exported from HP Helion Codar in JSON format and checked into the source repository. Jenkins can
be configured for continuous build. When an application developer checks in the code, a Jenkins build
is triggered and the application is deployed using an applicationmodel on a specific environment.
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Import and configure sample designs
Sample application designs are installed with HP Helion Codar andmust be imported before you can
use them. You can find the designs in

\Hewlett-Packard\Codar\CSAKit-4.2\Content Archives\topology\Codar

Import sample designs
Complete the following steps to import each of these designs:

1. Click the Designs tile in theManagement Console to go to themain Topology Designs screen.

2. Click Import.

3. Select a sample application zip file and click Import.

4. Repeat these steps to import the other sample design zip files.

The topology designs for these applications should now be listed under All Designs in themain
Topology Designs screen.

Configure sample designs
Each design includes a readme file with configuration instructions. These readme files can be found in
the directory with the sample designs.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation and Configuration Guide (Helion Codar 1.00)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to CSAdocs@hp.com.

We appreciate your feedback!
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